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Copyright 

The Dragon Burn™ software and the contents of this associated User Manual are the property of NEWTECH 
INFOSYSTEMS, INC. (NTI) and are protected by copyright. Any reproduction either in whole or in part is 
strictly prohibited. For additional copies of the software or this documentation, please contact NTI. 

Software as well as many other types of works are protected by international copyright laws. Unauthorized 
copying of those works in any manner may violate the rights of the owner of the copyright in those works and 
may expose you to civil and criminal penalties. 

You may not use Dragon Burn software to violate the copyright rights of others. NTI does not authorize you to 
use the Dragon Burn™ software for the purpose of violating the copyright rights of others. 

Information in this document is subject to change without notice. 

Trademarks 

Dragon Burn™ is a registered trademark of NewTech Infosystems, Inc. NTI CD-Maker Elite, NTI CD-Maker 
Pro, NTI CD-Maker, NTI CD-Maker MM, NTI CD-Maker Video, NTI CD-Copy Tools, CDR Explorer, NTI 
JewelCase Maker, NTI FileCD, EasySteps, and Overburn are trademarks of NewTech Infosystems, Inc. 
Windows is a trademark of Microsoft Corporation. All other product names or trademarks are property of their 
respective owners. 

License 

Use of this software constitutes your acceptance of these terms and conditions and your agreement to abide by 
them. You, the original purchaser, are granted a non-transferable, non-exclusive personal license to use the 
software. You may neither transfer the software or otherwise make it available to anyone else, nor may you 
copy, modify, disassemble, decompile, reverse engineer, revise or enhance the software, electronically transfer, 
or lease the software or this user manual. 

You may terminate this agreement at any time by destroying the software. This agreement will Use of this 
Software constitutes your acceptance of these terms and conditions and also terminate if you fail to comply with 
the terms and conditions of this agreement. You agree upon such termination to destroy the software. 

Limited Warranty 

NewTech Infosystems, Inc. warrants for a period of thirty (30) days from the date of delivery that, under normal 
use and without unauthorized modification, the program performs in substantial compliance with the User 
Manual and those set forth in NewTech Infosystems, Inc. authorized advertising material; that under normal 
use, the magnetic media upon which the software is distributed is substantially free from significant defects in 
materials and workmanship. Warranty claims must be made in writing during the Warranty Period and within 
seven (7) days of the observation of the defect, accompanied by evidence satisfactory to NewTech Infosystems, 
Inc. If NewTech Infosystems, Inc. is unable to correct it within ninety (90) days of the date you report the defect, 
you may return the software and accompanying materials to NTI distributor from where they were purchased (if 
not purchased directly from NewTech Infosystems, Inc.) and shall be shipped by the returning party with freight 
and insurance paid. 

EXCEPT AS STATED ABOVE, THERE IS NO OTHER WARRANTY, EXPRESSED OR IMPLIED, 
REGARDING THE PRODUCT INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 



 

 

Limit Of NewTech Infosystems, Inc. Liability 

NewTech Infosystems, Inc. entire liability for damages to you or any other party for any cause whatsoever, 
whether in contract or in tort, including negligence, shall not exceed the price you paid for the unit of the 
software that caused the damages or that are the subject matter of, or are directly related to, the cause of action. 
In no event will NewTech Infosystems, Inc. be liable for any damages caused by your failure to perform your 
obligations, or for any loss of data, profits, savings, or any other consequential and incidental damages, even if 
NewTech Infosystems, Inc. has been advised of the possibility of damages, or for any claims by you based on 
any third-party claim. 

Changes 

With reasonable efforts have been made in the preparation of this documentation to assure its accuracy, 
NTI assumes no liability resulting from errors or omissions in this document or from the use of the 
information contained herein. 
 
NOTICE 

NTI’s Dragon Burn software is designed to assist you in reproducing material in which you own the 
copyright or have obtained permission to copy from the copyright owner.  

NTI does not authorize you to use the software for the purpose of violating the copyright rights of 
others. Violating the copyright rights of others may result in severe civil and criminal penalties and may 
be prosecuted to the maximum extent possible under the law. 

NEWTECH INFOSYSTEMS, INC. takes no responsibility for any illegal use of the product. If you are 
not sure about your rights, please consult your legal advisor before using NTI software. 
 
Termination 
Your failure to comply with the terms in this Agreement shall terminate your license and this 
Agreement.  
 
U.S. GOVERNMENT RESTRICTED RIGHTS.   
 
The Software and user documentation is provided with RESTRICTED RIGHTS AND LIMITED 
RIGHTS.  Use, duplication, or disclosure by the Government is subject to restrictions as set forth in 
subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 
252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software--Restricted Rights 
at 48 CFR 52.227-19, as applicable. NewTech Infosystems, Inc., 5 Mason Avenue, Suite 150, Irvine, 
CA 92618 U.S.A. 
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First Things First 
Congratulations on your purchase of Dragon Burn. This User's Guide explains the features of 
Dragon Burn, its Macintosh® system requirements, and how to use Dragon Burn to create your own 
CDs.  

How to Use This Guide 
This Dragon Burn User's Guide includes four chapters, a Table of Contents, a Glossary, and an Index. 

Chapter 1: Introduction 
This chapter explains the features of Dragon Burn, system requirements, and how to install the Dragon 
Burn software. 

Chapter 2: Copying a CD 
This chapter explains how to copy an existing CD, and the options and settings that are available for the 
copy process. 

Chapter 3: Creating your own CD 
This chapter explains how to create a CD with your own custom contents, and all of the settings and 
options that correspond to your custom CD. 

Chapter 4: Reference 
This chapter includes a Troubleshooting section and contact information in case you need additional 
help. 

Dragon Burn Features 
Dragon Burn™ is a powerful, yet easy to use utility for creating CD-R (CD-Recordable) or CD-RW 
(CD-ReWritable) discs. 

� Create backup copies of your Macintosh files, folders or volumes. Use CD-R media if you 
want to create a permanent archive of your files. Alternatively, use CD-RW media if you want 
to be able to update or add to your files. 

� Create copies of your audio, data, mixed mode or CD Extra CDs. Dragon Burn can create 
backup copies of your existing CDs. 

� Create Audio CDs from your favorite AIFF, CDDA, MP3 or WAV files. 

� Extract your favorite audio tracks to AIFF or WAV files. 

� Easy "tabbed pane" system enables you to quickly step through the options available for 
creating your CDs. The Dragon Burn windows step you through the process of selecting the 
options and settings that you want for your CD. If you accidentally miss an important setting, 
Dragon Burn automatically detects the missing setting and can move you to the tabbed pane 
to add the missing setting. 

� Fast "drag and drop" support enables you to use the Macintosh Finder to choose the files and 
folders that you want to include on your CD. Simply drag the Finder icons into the Dragon 
Burn window to choose the contents of your CD. 
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� Create an "image file" that represents the entire contents of a CD. An image file can be used 
to create additional copies of the CD during subsequent work sessions. 

� Create and save a Layout of your Dragon Burn settings, as well as particular files and folders 
to be copied. The Layout feature makes it quick and easy to use Dragon Burn for creating 
archive copies of your important data. 

� Supports multiple file system formats. With Dragon Burn, you can create CDs in the standard 
Macintosh disc format. You can also create CDs in the ISO9660 format used by Windows 
computers, so you can open and use your files on those types of computers. You can also 
create "hybrid" CDs that contain a combination of the two disc formats. 

� Includes potential error and status reporting. Dragon Burn automatically creates a Log that 
shows potential errors, warnings and notes that relate to the disc creation process. You can 
view, print, or save the Log as a file on your Macintosh. 

� Accommodates a wide range of CD-recorder devices. For the latest list of compatible devices, 
refer to http://www.ntius.com/support/supdrives.cfm on the Internet. 

� Supports SCSI-based, USB 1.0 and FireWire-based CD-writers. Dragon Burn supports the 
highest-performance CD-writers available. 

System Requirements 
To use Dragon Burn, your Macintosh system must consist of the following: 

� Macintosh computer with Power PC processor. This includes the G3 and G4 Macintosh 
systems. 

� Macintosh System 9.1 or higher (which means a higher number). 

� 32MB of RAM 

� 2MB of free disk space for software installation 

� Compatible CD-burner  correctly installed or connected to your Macintosh. 

� CD-ROM drive, for installing the software and making a direct copy of an existing CD 

� *(Optional) 700MB of free disk space to create a disc image file. 
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Software Installation 
The Dragon Burn software is included on the Dragon Burn Software CD. Installation is easy, and 
should take less than a minute. 

ª To install the Dragon Burn software: 

1. Insert the Dragon Burn Software CD into the CD drive. In a moment, an icon is displayed 
on your desktop for the newly mounted CD. 

 
2. Double-click on the icon to display the Dragon Burn Installer window 

3. Double-click on the Install Dragon Burn icon. The Dragon Burn Installer menu is 
displayed. 

 
4.  Click the Install button to launch the Dragon Burn installer. 

 
5. Click Ok on the Installation Successful dialog. 

Notes: 
³ Click the Change button to install Dragon Burn into another folder on your computer. 

³ If you are using Dragon Burn with a FireWire or USB-based CD-writer, you must leave the 
box checked to install these drivers. 

³ If you are using Dragon Burn with a FireWire-based CD-writer, you may be prompted to 
restart your Macintosh the first time that you run the Dragon Burn application. 

Software installation is complete, and you are ready to use Dragon Burn as described in the following 
chapters. 
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Getting Started 
This chapter explains how to copy an existing CD, and all of the settings and options that you can 

Chapter 2 — Topics of discussion 
 

Getting Started 
Starting Dragon Burn 
About Copying CDs 
Using the Control Tabs 
CD Copy Overview 
CD Copy Procedure 
Options Settings 
Using a Disc Image File 
Using a CD Copy Layout 
Creating a Disc Image File 
Making a CD with a Disc Image File 
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choose for making a CD copy. 

Note:  
³ This chapter assumes that you have installed the Dragon Burn software as described in the 

previous chapter. If you haven't installed the software, refer to the Software Installation 
section. 

 

Starting Dragon Burn 

ª To start the Dragon Burn application: 

1. Locate the Dragon Burn folder on your hard disk drive. You will find the folder where 
you installed the software, as described in the section entitled Software Installation. 

2. Open the Dragon Burn folder, and double-click the Dragon Burn icon. In a moment, 
the Dragon Burn window appears, as shown in the following diagram: 

 

Note:  
³ If you are using Dragon Burn with a FireWire-based CD-writer, you may be 

prompted to restart your Macintosh the first time that you run the Dragon 
Burn application, or if you have updated your Macintosh system. 

3. Click the CD Copy icon to open the "Copy a CD" window. 

The Dragon Burn application is now running and ready for use. The following sections of this chapter 
describe the procedure for copying a CD, and the features and options that are available. 

About Copying CDs 
Dragon Burn is designed to make a duplicate of your source CD. You should be aware that there are 
copyright laws that may apply when you make a copy of a CD especially a CD that contains material 
you have not personally created. You are solely responsible for complying with all applicable copyright 
and intellectual property laws associated with the content of any CD. Keep in mind the following: 

� Software CDs. All commercial software is supplied with a Copyright License Agreement. 
You should carefully review the contents of this agreement before you make a copy of a 
software CD. 

� Music CDs. Music CDs that you buy in the store are also covered by copyright protection. 

� Copy Protection. Many software CDs contain special data encoding that prevents their being 
copied even by advanced applications such as Dragon Burn. If you attempt to copy a software 
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CD and receive error or warning messages in the Dragon Burn Log file, it is likely that the CD 
features copy protection. It may be impossible to create a copy of that CD. 

Using the Control Tabs 
The windows that appear in Dragon Burn feature a series of Control Tabs along the top. These Control 
Tabs appear in sequence according to the settings that you make to create a CD, as shown in the 
following diagram: 

 
When you make or confirm the settings that appear in each Control Tab, click the next tab in sequence 
to activate the pane and make the next settings. You can also use the Previous and Next buttons to 
move among the panes, as shown in the following diagram: 

 

Note:  
³ For many operations with Dragon Burn, you do not have to make or change 

settings in each of the Control Tab panes. However, it's a good idea to check 
the settings and controls "just to be sure" before you create a CD. 

CD Copy Overview 
You will perform the following step when you use Dragon Burn to copy a CD: 

1. Choose a Source. The Source pane automatically lists all the CD players/recorders 
connected to your Macintosh system. You use this pane to choose the device that has 
the CD you want to copy. 

2. Choose the CD Writer. The CD Writer pane lists all CD recorders connected to your 
Macintosh system. You use this pane to choose the recorder that will create the CD copy 
or choose CD Image Writer to create an image file of your source CD. 

3. Choose the Recording Options. If this is the first time you're copying a CD, trying a 
different recording speed, or have made other changes to your normal copy procedure, 
you should choose the Simulate Only Mode to test the system. Then choose the 
recording speed, buffer underrun error protection and eject options.  

4. Write the CD. If there are no unresolved issues then choose Write Session (potentially 
leaving room for more data on the CD) or to write the Disc.  

5. Review the Log. When the copy is complete, the Log pane shows any errors, warnings 
or notes that relate to the creation of the CD copy. 

Each of these steps is described in detail in the following sections of this chapter. 

CD Copy Procedure 

Note:  
³ To directly copy a CD, you need to have two CD drives connected to your Macintosh system: 

a CD-ROM drive (for the source CD), and a CD-writer drive (to make the copy). You can 
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still make a copy if you only have one CD drive by selecting that drive from both the source 
and CD Writer tabs. Dragon Burn will make a temporary disc image and then prompt you to 
put a blank CD in your recorder. You will need to have enough free hard disk space to hold 
the temporary image file when copying a CD from a single drive. 

ª To copy a CD: 

1. If you haven't already done so, start the Dragon Burn application. When you first start 
Dragon Burn, the Dragon Burn window appears on the screen. 
 
If the Dragon Burn window is not currently on the screen, choose New Layout from the 
File menu. 

2. Click the CD Copy icon to open the "Copy a CD" window. 

3. Insert the source CD (the one you want to copy) into the source drive of your 
Macintosh. 

4. Click the Source tab. The Source pane appears, as shown in the following diagram: 

  
5. Select the CD drive that contains your source CD. 
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6. Click the CD Writer tab. The CD Writer pane appears, as shown in the following 
diagram: 

 
7. Click to choose the CD-writer connected to your Macintosh system. If you have more 

than one CD-writer available, click to choose the one that you want to use. 

Notes:  

³ If your CD recorder does not appear in this list, click the Show All Devices 
check box. This will display a list of all the devices (CD-ROM, hard drive, etc.) 
that are connected to your Macintosh system 

³ You can also select the CD Image Writer to specify that the contents of the 
CD will be written as a CD Image File. For more information about this 
option, refer to the section entitled Using a Disc Image File 

8. Press the Eject button on your CD-recorder and insert a blank (recordable) CD into the 
drive tray. Press the Eject button a second time to close the drive tray, and make the 
blank CD available for use. 

Note:  

³ If you are using a single CD drive you will be prompted to remove the source 
disc and replace it with a blank piece of CD-R/RW media. 
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9. Click the Options tab. The Options pane appears, as shown in the following diagram: 

 
10. The first time you make a copy of a particular kind of CD (audio, data, etc.), select 

Simulate Only mode. This will cause Dragon Burn to use your Macintosh and the CD-
writer mechanism to go through all the actions of making a CD copy without actually 
recording to the CD. Once Dragon Burn has successfully "simulated" the recording, you will 
return to this step and select the Write mode to create the actual CD. 
 
If you want to specify a recording speed, click on the Recording Speed pop-up menu, 
and choose the setting that you want to use. The default setting is "Fastest," which sets 
the CD-writer to record at the fastest speed. More information about choosing a 
different speed for your CD-writer appears in the section entitled Troubleshooting. 
 
The other settings available in this pane are described in the section entitled Options 
Settings. 
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11. Click the Write tab. The Write pane appears, as shown in the following diagram: 

 
12. Click to choose Write Session or Write Disc: 

 
Write Session. This setting instructs Dragon Burn to write the contents of your source 
CD as a new volume on the destination disc. Depending upon the size of your source 
CD, this may leave space available for subsequent recording on the CD that you create.  
 
Write Disc. This setting instructs Dragon Burn to completely fill your destination CD 
with the contents of the source CD. This is the normal choice, so that the destination 
CD becomes a copy of the source CD. 
 
You can find more information about the differences between Write Session and Write 
Disc in the Glossary. 

13. At this point, Dragon Burn begins writing to the CD inserted in your CD-writer drive. A 
progress window appears, as shown in the following diagram: 

 
The first time you are copying a CD; you have selected the Simulate Only setting on the 
Options pane. In this case, the progress window shows the progress of this simulation, 
without actually writing to the CD. 

14. When Dragon Burn is finished creating your CD copy, the completed disc will eject 
from your CD-writer drive. Click the Log tab.  
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The first time you are copying a CD, this Log pane will report the results of the 
recording simulation. If the Log pane reports "Completed Successfully," return to step 
#9 and select the Write mode. Repeat the rest of this procedure from step #9. 

At this point, your CD copy is complete and ready for use. You should review the 
contents of the Log pane, and make sure that Dragon Burn hasn't reported any Errors or 
Warnings that relate to the CD copy you've created. 
 
If you want to create a second (or subsequent) copy of the same CD, click the Write CD 
button that appears in the Log pane. 

This procedure is complete. If there were no Errors or Warnings reported in the Log 
pane (step #14), you can use your CD copy with your Macintosh the same as you would 
the original (source) CD. 

If Errors or Warnings were reported in step #14, refer to the Troubleshooting section (in 
Chapter 4: Reference). 

Options Settings 
This section describes the settings that are available in the Options pane. 

� Recording Speed. This pop-up menu enables you to choose the recording speed that will be 
used for writing the CD. In general, you should leave this set to "Fastest," which will use the 
highest speed available for your CD-writer depending on the piece of media you are using in 
that drive. If you receive error messages in the Log pane when simulating or while actually 
writing a CD, you should experiment with lower speed settings. For example, if your CD-
writer is rated at a 6x speed, you should try the 4x setting. 
 
Be aware that some brands of blank CD media (particularly inexpensive brands) may not 
record reliably at the higher speeds. If you have trouble creating a CD with a certain brand of 
CD media, try using this menu to choose a lower recording speed or try another brand of 
media. 

� Mode. This setting is used to specify the write mode for the recording process. Selecting the 
Write option will cause the CD recorder to write the data to the CD. Simulate Only causes 
Dragon Burn to go through all of the procedures of creating an actual CD, and will report any 
potential errors in the Log pane but no CD is created. Selecting Simulate & Write will cause 
the first pass to simulate (test) the recording process and then actually write the CD on the 
second pass. 
 
This setting is useful of you are having problems copying a particular CD, and want to 
experiment with different settings (such as a lower Recording Speed). 

� Buffer underrun error protection. This option enables or disables the buffer underrun error 
correction on the target CD-R/CD-RW recorder. Drives supporting this technology will 
prevent the creation of bad CDs due to the data flow to the target drive.  

� Session-At-Once/Disc-At-Once. This option causes Dragon Burn to copy the disc using 
Session-At-Once when you use the Write Session option and Disc-At-Once when you click 
the Write Disc from the Write Tab. Dragon Burn will copy your CD using Track-At-Once 
when this option is unchecked. 
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� Erase Disc Before Writing. If you're working with a CD-RW (CD-re-writable) disc, Dragon 
Burn offers the option of erasing any previous data that may be on the disc. This allows you 
to erase all of the data on a CD-RW disc before you write your new data to the disc 

Using a Disc Image File 
Dragon Burn gives you the option of writing the contents of an audio, data, mixed-mode or CD Extra 
CD as a disc image file. A disc image file is a single (usually large) file created on your Macintosh that 
represents the entire contents of a CD. 

The advantage to creating a disc image file is that the it can be used to create subsequent disc copies 
without the source CD. This is particularly useful if you will be making multiple copies of a CD, and 
may not have access to the original source CD. 

Using a CD Copy Layout 
The Copy procedure described previously in this chapter explains how to use all of Dragon Burn's 
Control Tab panes to copy a CD.  

ª To copy a CD using a CD Copy Layout: 

1. If you haven't already done so, start the Dragon Burn application. When you first start 
Dragon Burn, the Dragon Burn window appears on the screen. 
 
If the Dragon Burn window is not currently on the screen, choose New Layout from the 
File menu. 

2. Click the CD Copy icon to open the "Copy a CD" window. 

3. Insert the source CD into your CD-ROM drive. An icon for the source CD appears in 
the Finder desktop. 

4. Select the Source drive from the Source pane. The drive will be highlighted when 
selected. 

5. Insert a blank recordable CD into your CD-writer. 

6. Click the CD Writer tab and select the target drive or choose CD Image Writer to create 
an image file of the CD being copied. 

7. Select the Option tab if you wish to modify your recording options. 

8. Click the Write tab and choose Write Session or Write Disc, as appropriate. 

9. When the copy is complete, the Log pane is selected automatically, reporting the results 
of the CD copy process. The disc is ready for use. 

Creating a Disc Image File 

ª To create a disc image file: 

1. Make sure that you have enough space on your hard disk drive for the disc image file. 
The file will be as large as the entire contents of the source CD disc.  
 
To determine the size of the source CD, click on the CD's icon in the Finder, and 
choose Get Info from the File menu. You must have at least this much free space on a 
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single hard disk drive in your Macintosh. Close the Get Info window when you are 
finished reviewing the disc information. 

2. If you haven't already done so, start the Dragon Burn application. When you first start 
Dragon Burn, the Dragon Burn window appears on the screen. 
 
If the Dragon Burn window is not currently on the screen, choose New Layout from the 
File menu. 

3. Click the CD Copy icon to open the "Copy a CD" window. 

4. Insert the source CD into your CD-ROM drive. An icon for the source CD appears in 
the Finder desktop. 

5. Select the CD drive that contains your source CD. 

6. Click the CD Writer tab. 

7. Select the CD Image Writer and click the Choose button. A dialog box appears, 
prompting you to enter a name for the disc image file, as shown in the following 
diagram: 

 
8. Make sure that the Macintosh disk and folder that is selected has room for the disc image 

file. If necessary, use the pop-up menu to choose the hard disk drive that you checked in 
step #1. 

9. Enter a name for the disc image file, and then click on the Save button to continue. 
 
You are returned to the CD Writer pane of the Copy a CD window. 

10. Select the Option tab if you wish to modify your recording options. 

11. Click the Write CD button. 

12. Click the Write Disc button.  

At this point, the data from the CD you chose in step #4 is written to the disc image file. When the 
process is complete, the Write pane of the Copy a CD window remains on the screen. You are now 
ready to use the CD image file to create CDs, as described in the following section. 
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Making a CD with a Disc Image File 

ª To use a disc image file to create a CD: 

1. If you haven't already done so, start the Dragon Burn application. When you first start 
Dragon Burn, the Dragon Burn window appears on the screen. 
 
If the Dragon Burn window is not currently on the screen, choose New Layout from the 
File menu. 

2. Click the CD Copy icon to open the "Copy a CD" window. 

3. Click the Add Image... button. A dialog box appears, prompting you to choose the CD 
image file, as shown in the following diagram: 

 
4. If necessary, use the pop-up menu to navigate to the folder that contains the CD image 

file. When you've found the file, click to select it (so it's highlighted), and then click the 
Select button to continue. 

5. Click the CD Writer tab. 

6. Select the target CD-R/RW recorder. 

7. Select the Option tab if you wish to modify your recording options. 

8. Click the Write CD button.  

9. Click the Write Disc button.  

At this point, all of the data from the CD image file you chose in step #4 is used to create a new CD 
copy. When the process is complete, the Log pane is selected automatically, showing the results of the 
Copy procedure. 
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Getting Started 
This chapter explains how to use Dragon Burn to create your own "custom CDs" meaning the content 
of the CD is based on files that you choose from the drives connected to your Macintosh system. With 
Dragon Burn, you simply create a layout file that contains the information about the CD you want to 
create and let Dragon Burn do the rest. These CD layouts can be saved and used again to create 
additional copies of any CD you create. 

Supported CD Format Types 
Using Dragon Burn, you can create four types of CD-R discs: Audio CD, Data CD (CD-ROM), 
Mixed-Mode CD and CD Extra. 

A CD-ROM disc contains data only. For example, when you back up all the data files from your hard 
disk to CD, the disc that will be created is a CD-ROM disc. When creating a Data CD, you can also 
choose the file format for the completed CD. This can be the standard Macintosh file format (HFS), the 
ISO9660 file format (used by Windows-based computers), or even a combination of the two formats 
on the same CD. 

An Audio CD disc contains only digital audio information. The sources of digital audio are Audio CD 
(music or songs) on a disc in a CD-ROM drive, Wave, mp3 and AIFF files on your hard disk. 

A Mixed Mode CD contains both data and digital audio. Data is recorded on the first track, while 
audio is on tracks 2 to 99 of the same disc. 

A CD Extra, also known as CD Plus or Enhanced CD, includes two sessions with the first session 
containing up to 98 audio tracks and the second session containing a data track written in the CD-ROM 
XA format. 

Creating a Data CD 
With Dragon Burn, you can easily make copies of any files and folders on your Macintosh. You can use 
the Finder to drag-and drop your files and folders onto the Dragon Burn Layout window, or you can 
use the Select File or Folder dialog box to select the files and folders that you want. 

Dragon Burn supports both CD-R (write once) and CD-RW (write and then re-write) media. This 
makes Dragon Burn quick and easy to use for making archive copies of your computer data (using CD-
R media), as well as backup copies that can be updated (using CD-RW media). 

ª To create a Data CD(CD-ROM): 

1. If you haven't already done so, start the Dragon Burn application. When you first start 
Dragon Burn, the Dragon Burn window appears on the screen. 
 
If the Dragon Burn window is not currently on the screen, choose New Layout from the 
File menu. 

2. Click the Data CD icon to open the "Data CD" window. A new, Untitled Layout 
window appears. 
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3. In the Control Tabs that appear at the top of the Layout window, the Data tab is selected 
automatically. The Data pane is used to list the files and folders that will be written onto 
the CD. There are two ways to choose your files and folders in the Data pane: 

 
Drag and drop files and folders from the Finder. Simply drag the files and folders that 
you want into the Data pane, and release the mouse button. The files and folders that 
you have selected appear as a scrolling list in the Data pane. 
 
or: 
 
Click Add… button to select files and folders from the Finder. If necessary, click the 
Open button to open folder(s). Then, click to select the file or folder, and click the 
Choose button to include it in the Data pane. 
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4. When you have added the files and folders that you want to include on the CD, the 
Layout window will display a list of those items, as shown in the following diagram: 

 
If you've accidentally added a file or folder that you do not want to include on the CD, 
click to select the item, and then click the Remove Item button. 

Note:  

³ As you add files and folders to the list, the total combined size of the files and 
folders appears in the lower-right corner of the Data pane. Make sure that the 
combined size of the files and folders does not exceed the capacity of your CD 
media (generally, 1% less than the rated maximum capacity of the CD. For 
example, if the CD is rated for a maximum of 650MB, you should not try to 
write more than 644MB). 

5. When you are satisfied with the list of files and folders for your new CD, click the CD 
Writer tab.  

If your CD-writer does not appear in the list of recorder devices, click the Rescan button. 
Dragon Burn will then display a list of drives connected to your Macintosh system. 

6. Press the Eject button on your CD-writer drive, and insert a blank (recordable) CD into 
the drive tray. Press the Eject button a second time to close the drive tray, and make the 
blank CD available for use. 
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7. Click the Options tab. The Options pane appears, as shown in the following diagram: 

 
8. The first time you create a particular kind of CD (audio, data, etc.), choose the Simulate 

Only mode. This will cause Dragon Burn to use your Macintosh and the CD-writer 
mechanism to go through all the actions of making a CD without actually recording to the CD. 
Once Dragon Burn has successfully "simulated" the recording, you will return to this 
step and select the Write mode to create the actual CD. 

If you want to specify a recording speed, click on the Recording Speed pop-up menu, 
and choose the setting that you want to use. The default setting is "Fastest," which sets 
the CD-writer to record at the fastest speed. Do not choose a speed faster than the 
highest rating for your particular CD-writer. More information about choosing a 
different speed for your CD-writer appears in the section entitled Troubleshooting. 
 
The other settings available in this pane are described in the section entitled Options 
Settings. 

9. Click the Write tab. 

If any items are listed in the Unresolved Issues area of the Write pane, they must be 
corrected before you proceed. Clicking the Show button automatically takes you to the 
Layout pane where you make the setting for the issue that needs to be resolved. 

10. Click to choose Write Session or Write Disc: 

Write Session. This setting instructs Dragon Burn to write the contents of your source 
CD as a new volume on the destination disc. Depending upon the size of your source 
CD, this may leave space available for subsequent recording on the CD that you create.  
 
Write Disc. This setting instructs Dragon Burn to completely fill your destination CD 
with the contents of the source CD. This is the normal choice, so that the destination 
CD becomes a copy of the source CD. This disc is finalized and no more data may be 
added to that CD. 
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You can find more information about the differences between Write Session and Write 
Disc in the Glossary. 

11. Dragon Burn begins writing to the CD inserted in your CD-writer drive. A progress 
window appears, as shown in the following diagram: 

 
12. When Dragon Burn is finished creating your custom CD, the completed disc will eject 

from your CD-writer drive. Click the Log tab to view the status of the recording process.  

The first time you are copying a CD, this Log pane will report the results of the 
recording simulation. If the Log pane reports "Simulation Successful," return to step #8 
and repeat the rest of this procedure from step #8. 

This procedure is complete.  

At this point, your Data CD is complete and ready for use. You should review the contents of the Log 
pane, and make sure that Dragon Burn hasn't reported any Errors or Warnings that relate to the CD 
you've created. 

If you want to create a second (or subsequent) copy of the same CD, click the Write CD button that 
appears in the Log pane.  

If Errors or Warnings were reported in step #12, refer to the Troubleshooting section (in Chapter 4: 
Reference). 

Note:  
³ If you close the Layout window or quit Dragon Burn, you are prompted to save the settings 

you have made in the Layout window. This is the same as saving a Layout, as described in the 
following section. 
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Saving a CD Layout 
Once you've made any settings in a Layout window, you can save those settings for future use. For 
example, the previous procedure explained how to use Dragon Burn to backup data to a Data CD. You 
can save all of those settings as a CD Layout, and use them to quickly make future backup copies of the 
same files and folders. 

You can save as many different CD Layouts as you want. For example, you might save a Layout for 
backing up business files, and then specify different Layout to backup image files. 

ª To save your CD Layout: 

1. With a Layout window on the screen, make changes to any of the settings in any of the 
Control Tab panes. 

Note:  

³ You do not actually have to record a CD. Simply make the settings that you 
want to use for recording a CD. 

2. Choose Save Layout or Save Layout As… from the File menu. 

3. Enter a name for the Layout. 

4. If you want to save the Layout in a different location, navigate to the volume and folder 
where you want to save the Layout. 

5. Click the Save button.  

At this point, all of the settings in the current Layout window are saved, and can easily be opened and 
used for a future session with Dragon Burn. 

Opening a Saved CD Layout 

ª To open and use a saved CD Layout: 

1. Choose Open Layout from the File menu. 

2. Click to choose the Layout file that you want to use. If necessary, navigate to the folder 
that contains the Layout file. 

3. Click the Open button. The Layout window is displayed with all of the settings you 
specified when you saved the Layout. 

At this point, the Layout window is open and ready for use. You can use the settings in your Layout file, 
or you can make any changes you want for creating a new CD. 
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Creating an Audio CD 
You can use an Audio CD layout to create a CD comprised of audio files in the AIFF, wave or mp3 file 
formats or tracks directly from your favorite Audio CD.  

You can also use Dragon Burn to specify the pause between the individual audio tracks, and rearrange 
the order that the tracks are recorded onto the CD. 

ª To use Dragon Burn to create an Audio CD: 

1. If you haven't already done so, start the Dragon Burn application. When you first start 
Dragon Burn, the Dragon Burn window appears on the screen. 

If the Dragon Burn window is not currently on the screen, choose New Layout from the 
File menu. 

2. Click the Audio CD icon to open the "Audio CD" window. A new, Untitled Layout 
window appears. 

3. The Audio pane is used to define the audio files that will be copied to your Audio CD. 
There are two ways to choose the audio files that you want to add to the Audio pane: 

 
Drag and drop an audio file icon from the Finder. Simply drag the icon of the audio file 
onto the Audio pane, and release the mouse button. The audio files that you have 
selected appear as a scrolling list in the Audio pane. 

or: 
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Click the Add File button. A dialog box appears, as shown in the following diagram: 

 
Select the file that you want to add, and then click the Add button to add it to the Audio 
pane. If you have selected a folder then click the Open button to expand the folder and 
list its contents. 

4. Repeat the previous step for all of the audio files that you want to include on your Audio 
CD. When you're finished, the Audio pane shows a list of the files you have selected, as 
shown in the following diagram: 
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5. You can play a track by selecting it and positioning the mouse cursor just to the right of 
the track number. Click the mouse button when the cursor changes to a speaker to play 
the track. The dialog below shows the playback control: 

 
Note:  

³ You can use the playback controls to adjust the volume, play/pause the track 
and fast forward/reverse the track playback position within the track. 

6. Choose the order that you want for the audio files you have selected. To change the 
order, click on the name of an audio file, and drag it to a different position. Drag the file 
up to have it appear earlier on the CD; drag the file down to have it appear later on the 
CD. The audio file that appears at the top of the scrolling list will be the first track of the 
CD you create. 

If you want to remove an audio file that appears in the list, click to select the file, and 
then click the Remove button. 

7. Next, choose the Pause time that you want for the individual audio tracks on your 
custom CD. Click the pop-up menu that appears with each audio track, and choose the 
Pause time. You can choose from 0 to 5 seconds Pause time between the selected track 
and the next track. 

8. Click the CD Writer tab, and choose your CD Writer. 

9. Click the Options tab, and choose the options that you want for the Audio CD. The 
same Options selections apply as described in the section entitled Options Settings. 

As with any use of Dragon Burn, the first time you create a particular kind of CD 
(audio, data, etc.), choose the Simulate Only mode. This will cause Dragon Burn to use 
your Macintosh and the CD-writer mechanism to go through all the actions of making a 
CD without actually recording to the CD. Once Dragon Burn has successfully "simulated" the 
recording, return to this step and select the Write mode option to create the actual CD 

10. Insert blank CD media into your CD-writer. 
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11. Click the Write tab, and choose Write Session or Write Disc, as appropriate. 

Note:  

³ If the combined contents of your audio files are too large to be copied onto a 
CD, the Unresolved Issues section of the Write pane will display an alert. In 
this case, click the Show button to return to the Audio pane and remove audio 
files as appropriate. 

12. When Dragon Burn is finished creating your Audio CD, the completed disc will eject 
from your CD-writer drive. Click the Log tab, and review the contents of the Log pane. 

This procedure is complete. 

Creating a Mixed Mode CD 
Mixed-Mode refers to the combination of CD-ROM and Audio CD formats on the same disc. A 
Mixed-Mode disc contains one track of CD-ROM data followed by one or more Audio CD tracks. You 
can use the Mixed Mode CD Layout window to create a Mixed Mode CD. 

The options available for the data and audio tracks are the same as the corresponding layout type. The 
Mixed Mode layout is comprised of a data tab and an audio tab similar to those you have already used 
when creating a data or audio CDs. While in the data pane you have the same choices of file formats 
and when creating the audio portion of the layout you have all the same options and control that you 
had while creating an audio CD.  

ª To use Dragon Burn to create a Mixed Mode CD: 

1. If you haven't already done so, start the Dragon Burn application. When you first start 
Dragon Burn, the Dragon Burn window appears on the screen. 

If the Dragon Burn window is not currently on the screen, choose New Layout from the 
File menu. 

2. Click the Mixed CD icon to open the "Mixed CD" window. A new, Untitled Layout 
window appears. 

3. In the Control Tabs that appear at the top of the Layout window, the Data tab is selected 
automatically. The Data pane is used to list the files and folders that will be written onto 
the CD. There are two ways to choose your files and folders in the Data pane: 

Drag and drop files and folders from the Finder. Simply drag the files and folders that 
you want into the Data pane, and release the mouse button. The files and folders that 
you have selected appear as a scrolling list in the Data pane. 
 
or: 
 
Click the Add File/Folder button. The Select File or Folder dialog box appears. Use 
this dialog box to navigate to the location of your files or folders. If necessary, click the 
Open button to open folder(s). Then, click to choose the file or folder, and click the 
Choose button to include it in the Data pane. 

4. The Layout window will display a list of those items that you have added to your data 
track layout. If you've accidentally added a file or folder that you do not want to include 
on the CD, click to choose the item, and then click the Remove Item button. 
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 Note:  

³ As you add files and folders to the list, the total combined size of the files and 
folders appears in the lower-right corner of the Data pane. Make sure that the 
combined size of the files and folders does not exceed the capacity of your CD 
media (generally, 1% less than the rated maximum capacity of the CD. For 
example, if the CD is rated for a maximum of 650MB, you should not try to 
write more than 644MB). 

5. When you are satisfied with the list of files and folders for your new CD, click the Audio 
tab. The Audio pane is used to define the audio files that will be included in the audio 
track portion of your Mixed Mode CD. There are two ways to choose the audio files that 
you want to add to the Audio pane: 

Drag and drop an audio file icon from the Finder. Simply drag the icon of the audio file 
onto the Audio pane, and release the mouse button. The audio files that you have 
selected appear as a scrolling list in the Audio pane. 

or: 

Click the Add File button. Click to choose the file that you want to add, and then click 
the Open button to add it to the Audio pane. 

6. Repeat the previous step for all of the audio files that you want to include on your Mixed 
Mode CD. When you're finished, the Audio pane shows a list of the files you have 
selected. 

7. With audio files selected in the Audio pane, you can review file information that relates 
to the audio files you have selected. Click the triangle that appears to the left of the file 
name, and additional information will appear in the scrolling list. 

8. Choose the order that you want for the audio files you have selected. To change the 
order, click on the name of an audio file, and drag it to a different position. Drag the file 
up to have it appear earlier on the CD; drag the file down to have it appear later on the 
CD. The audio file that appears at the top of the scrolling list will be the first audio track 
of the CD you create. 

If you want to remove an audio file that appears in the list, click to select the file, and 
then click the Remove button. 

9. Next, choose the Pause time that you want for the individual audio tracks on your 
custom CD. Click the pop-up menu that appears with each audio track, and choose the 
Pause time. You can choose from zero - five seconds Pause time between the selected 
track and the next track. 

10. Click the CD Writer tab, and choose your CD Writer. 
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11. Click the Options tab, and choose the options that you want for the custom CD. The 
same Options selections apply as described in the section entitled Options Settings. 

As with any use of Dragon Burn, the first time you create a particular kind of CD 
(audio, data, etc.), choose the Simulate Only mode. This will cause Dragon Burn to use 
your Macintosh and the CD-writer mechanism to go through all the actions of making a 
CD without actually recording to the CD. Once Dragon Burn has successfully "simulated" the 
recording, return to this step select the Write mode option to create the actual CD. 

12. Insert blank CD media into your CD-writer. 

13. Click the Write tab, and choose Write Session or Write Disc, as appropriate. 

14. When Dragon Burn is finished creating your Mixed Mode CD, the completed disc will 
eject from your CD-writer drive. Click the Log tab, and review the contents of the Log 
pane. 

Note:  

³ Check the Unresolved Issues section of the Write pane for any outstanding 
issues for this layout. In this case, click the Show button to return to the layout 
pane containing the error and make corrections as appropriate. 

This procedure is complete. 

Creating a CD Extra Disc 
A Mixed-Mode CD contains data in the first track followed by one or more audio tracks, in a single 
session. A normal audio CD player attempts to play all tracks in succession. This results in a very loud 
noise and possible damage when playing a Mixed-Mode CD in a normal CD player. CD Extra, also 
known as CD Plus or Enhanced CD, is the solution to the above problem. It contains two sessions. 
The first session contains up to 98 audio tracks and the second session contains a data track written in 
the CD-ROM XA format. 

Playing a CD Extra disc in a normal Audio CD player plays the audio tracks in the first session, and 
never reads beyond the first session, so the data track is never played and the loud noise and possible 
damage are avoided. A CD-ROM drive that is able to read a multisession CD, however, reads the last 
session on the CD, so it finds the data track. The application can then be used to play back the sound. 

Again, all options available for the data and audio tracks are the same as the corresponding layout type. 
A CD Extra layout is comprised of an audio tab and a data tab similar to those you have already used 
when creating a data or audio CDs. While in the data pane you have the same choices of file formats 
and when creating the audio portion of the layout you have all the same options and control that you 
had while creating an audio CD.  

ª To use Dragon Burn to create a CD Extra disc: 

1. If you haven't already done so, start the Dragon Burn application. When you first start 
Dragon Burn, the Dragon Burn window appears on the screen. 

If the Dragon Burn window is not currently on the screen, choose New Layout from the 
File menu. 

2. Click the CD Extra icon to open the "CD-Extra" window. A new, Untitled Layout 
window appears. 
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3. In the Control Tabs that appear at the top of the Layout window, the Audio tab is 
selected automatically. The Audio pane is used to define the audio files that will be 
included in the audio track portion of your CD Extra disc. There are two ways to choose 
the audio files that you want to add to the Audio pane: 

Drag and drop an audio file icon from the Finder. Simply drag the icon of the audio file 
onto the Audio pane, and release the mouse button. The audio files that you have 
selected appear as a scrolling list in the Audio pane. 

or: 
 
Click the Add File button. Click to choose the file that you want to add, and then click 
the Open button to add it to the Audio pane. 

4. Repeat the previous step for all of the audio files that you want to include on your CD. 
When you're finished, the Audio pane shows a list of the files you have selected. 

5. With audio files selected in the Audio pane, you can review file information that relates 
to the audio files you have selected. Click the triangle that appears to the left of the file 
name, and additional information will appear in the scrolling list. 

6. Choose the order that you want for the audio files you have selected. To change the 
order, click on the name of an audio file, and drag it to a different position. Drag the file 
up to have it appear earlier on the CD; drag the file down to have it appear later on the 
CD. The audio file that appears at the top of the scrolling list will be the first audio track 
of the CD you create. 

If you want to remove an audio file that appears in the list, click to select the file, and 
then click the Remove button. 

7. Next, choose the Pause time that you want for the individual audio tracks on your 
custom CD. Click the pop-up menu that appears with each audio track, and choose the 
Pause time. You can choose from zero – five seconds Pause time between the selected 
track and the next track. 

8. When you are satisfied with the list of audio files for your new CD, click the Data tab. 
The Data pane is used to list the files and folders that will be written onto the CD. There 
are two ways to choose your files and folders in the Data pane: 

Drag and drop files and folders from the Finder. Simply drag the files and folders that 
you want into the Data pane, and release the mouse button. The files and folders that 
you have selected appear as a scrolling list in the Data pane. 
 
or: 
 
Click the Add File/Folder button. The Select File or Folder dialog box appears. Use 
this dialog box to navigate to the location of your files or folders. If necessary, click the 
Open button to open folder(s). Then, click to choose the file or folder, and click the 
Choose button to include it in the Data pane. 
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9. The Layout window will display a list of those items that you have added to your data 
track layout. If you've accidentally added a file or folder that you do not want to include 
on the CD, click to choose the item, and then click the Remove Item button. 

Note:  

³ As you add files and folders to the list, the total combined size of the files and 
folders appears in the lower-right corner of the Data pane. Make sure that the 
combined size of the files and folders does not exceed the capacity of your CD 
media (generally, 1% less than the rated maximum capacity of the CD. For 
example, if the CD is rated for a maximum of 650MB, you should not try to 
write more than 644MB). 

10. Click the CD Writer tab, and choose your CD Writer. 

11. Click the Options tab, and choose the options that you want for the custom CD. The 
same Options selections apply as described in the section entitled Options Settings. 

As with any use of Dragon Burn, the first time you create a particular kind of CD 
(audio, data, etc.), choose the Simulate Only mode. This will cause Dragon Burn to use 
your Macintosh and the CD-writer mechanism to go through all the actions of making a 
CD without actually recording to the CD. Once Dragon Burn has successfully "simulated" the 
recording, return to this step and select the Write mode option to create the actual CD. 

12. Insert blank CD media into your CD-writer. 

13. Click the Write tab, and choose Write Session or Write Disc, as appropriate. 

14. When Dragon Burn is finished creating your Mixed Mode CD, the completed disc will 
eject from your CD-writer drive. Click the Log tab, and review the contents of the Log 
pane. 

Note: 

³ Check the Unresolved Issues section of the Write pane for any outstanding 
issues for this layout. In this case, click the Show button to return to the layout 
pane containing the error and make corrections as appropriate. 

This procedure is complete. 



C R E A T I N G  Y O U R  O W N  C D  

Creating your own CD     35 

Extracting Audio Files 
You can create AIFF sound files from your audio track on CD or from out format sound files like mp3 
and Wave. In addition, you can also create a wave file from an AIFF audio file. 

ª To extract an AIFF file from an audio track or file: 

1. Click the Audio Tab from the Audio CD layout. 

 
2. Select the track to extract. 
3. Select the location and name of the new file using the Save Audio File As dialog. 
4. Click Save to begin the extraction process. 
5. Click OK when the Extraction Complete dialog is displayed.  

This procedure is complete. 

Note: 
³ Dragon Burn will create a wave file when the source file is in the AIFF format.  

Displaying Disc Information 
Additional information about the contents and status of a CD can be displayed from the CD Writer 
Tab of any layout or the Source Tab of the Copy a CD layout. 
Disc Type 
The disc type can be one of the following: (1) CD-DA or CD-ROM disc; (2) CD-I disc; (3) CD-ROM 
XA disc. 
Disc Status 

1. Blank Disc: a blank CD-R disc.  
2. Recordable Disc: not a blank disc but you can still use this disc to record. That means the disc 

has not been finalized yet. 
3. Unrecordable Disc: either a conventional CD or Disc-At-Once CD-R disc. You cannot use 

this disc to record. 
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Used Space 

This field shows the used space on the disc, as expressed in “minutes: seconds: frames.”  

Free Space 

This field shows the free and available space on the disc, as expressed in “minutes: seconds: frames”. If 
you insert a finalized this field will be zero, indicating no free space and the status will be displayed as 
unrecordable. 

ª To display the status of a CD-R/RW disc: 

1. Select the CD burner that contains the disc you wish to check the status. 

2. Click the Disc Info button. 

 
3. Check the Detail Mode to see additional details about the disc. 

 
4. Click Ok to close the Disc Info dialog.  

This procedure is complete. 
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Using Re-Writable Discs 
If you're working with a CD-RW (CD-ReWritable) disc, Dragon Burn offers the option of erasing any 
previous data that may be on the disc before making your CD. Be aware that using this option may add 
considerable time to the process of creating a CD. 

ª To erase the data on a CD-RW disc when making a CD: 

1. Click the CD Writer tab from any open CD layout. The Options pane appears, as shown 
in the following diagram (Copy CD Layout shown here): 

 
2. Click the Erase Disc button. 

3. Choose Full or Quick Erase to erase the CD-RW disc in the selected drive.  

This procedure is complete. 
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Specifying File Formats 
With Dragon Burn, you can choose the file format that is used for the data on your custom CD. Check 
boxes appear in the Data pane of the Layout window, and they enable you to choose the data format 
for the files, folders and audio files that you write on your CD. 

ª To specify a file format for the data on a CD: 

1. Click the Data tab from your open Data CD, Mixed Mode CD or CD Extra layout. The 
Data pane appears, as shown in the following diagram (Data CD Layout shown here): 

 
2. Click to choose the file format options that you want for your custom CD. 

3. Proceed to choose any files and folders that you want, CD-writer, and Options that will 
be used to write your CD. 

4. Click the Write tab to activate the Write pane, and write your CD in the normal manner. 

This procedure is complete. 
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File Format Options 
The following file format options are available: 

� MAC Volume. This setting creates a mountable Macintosh volume on the target CD. These 
volumes are limited to the space available on the CD media 

� MS-DOS. This setting defines that the files and folders you have selected in the Data pane 
will be written in the 8.3 MS-DOS file format.. 

� Joliet(MS-DOS/Windows). The Joliet file system was proposed and implemented by 
Microsoft. Joliet is based on the ISO9660 (1988) standard. 
 
If a CD is created using the Joliet file system, it may only be read back under 
Windows 95/Windows NT 4.0 or later, and may not be read back on other platforms. Under 
the Joliet file system, the number of characters allowed in long file name is up to 64 and the 
allowed number in a long directory is up to 64 characters. However, the total number of 
characters for a file name plus its full path cannot exceed 120. 

� HFS. This setting uses the Macintosh Type and Creator information (associated with 
Macintosh files), and writes this information into a special area of the CD. The result is that 
the Macintosh can recognize Macintosh files in the usual manner (so that you can double-click 
on a file to launch its related application) 

� HFS+. This setting creates CDs compatible with the Macintosh HFS+ file system. The result 
is that the Macintosh can recognize Macintosh files in the usual manner (so that you can 
double-click on a file to launch its related application) 

� Hybrid (HFS/MS-DOS). This format contains the MS-DOS file information, as well as 
files in the Macintosh HFS file format. In this case, all of the files that you specify in the 
Layout window are written twice onto the CD that you create: once in the MS-DOS file format 
and once in the Macintosh HFS file format. 

� Hybrid (HFS+/Joliet). This format contains the Joliet file information, as well as files in the 
Macintosh HFS+ file format. In this case, all of the files that you specify in the Layout 
window are written twice onto the CD that you create: once in the Joliet file format and once in 
the Macintosh HFS+ file format. 
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Chapter 4 — Topics of discussion 
 

Introduction 
Contacting NewTech Infosystems, Inc. 
Troubleshooting 
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Introduction 
This chapter includes Troubleshooting information, a Glossary, and contact information in 
case you need additional help for using Dragon Burn. 

Contacting NewTech Infosystems, Inc. 
If you have a problem that you cannot resolve, first be sure that you have checked the following: 

� Reviewed the contents of this User’s Guide 

� Checked the Troubleshooting section, and tried the suggestions for the various problems 
listed in that section. 

� Reviewed the contents of the ReadMe file that appears on the Dragon Burn Software CD. 

� If you have Internet access: Refer to our web site at: 
 
   www.ntius.com 

At this site, you will find information about the latest software upgrades and revisions that are available. 

Technical Support 

ª To request assistance from our Technical Support department: 

1. Via Email: support@ntius.com 

Hours: Monday - Friday, 8:00 AM - 5:00 PM (PST) 
Troubleshooting  
This section includes troubleshooting information: a series of common questions that relate to 
the operation of Dragon Burn, and the answers to those questions. 

Before you tackle any of the Troubleshooting issues that appear in this section, you should 
take a moment to review the procedures that appear in this User’s Guide.  Frequently, what 
appears to be a problem can easily be solved by carefully following the directions that appear 
in the procedures. 

My CD-writer doesn't appear in the list of available devices. 
� Make sure that you have turned on the power for your CD-writer.  Make sure that the CD-

writer is connected to an appropriate power source. 
� Check to make sure that your CD-writer is correctly connected to your Macintosh system.   

 
If you’re using an internal CD-writer, check that the ribbon cable is firmly seated onto the 
back of the CD-burner and that you have connected the power cable to the CD-writer. 
 
If you’re using an external CD-writer, check that the data cable is firmly connected to your 
Macintosh, and (the other end) to your CD-writer.  With an external SCSI CD-writer, you also 
need to make sure that the SCSI ID number is set correctly, and that the SCSI termination is 
correct for your CD-writer.  Refer to the Owner’s Manual supplied with your SCSI CD-writer 
for SCSI ID and SCSI termination information. 
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Disc is not ready 
� Press the Eject button on your CD-writer, and make sure that a blank CD is inserted in the 

CD-writer.  Press the Eject button a second time to pull the blank CD into the CD-writer. 
� Try a different blank CD.  Sometimes, errors in the CD media can result in a "disc not ready" 

message. 
� Check the connections for your CD-writer.  A loose connection can result in a "disc not 

ready" message. 
� Check the CD-writer.  If the manufacturer of the CD-writer included diagnostic software, use 

that software to confirm that the CD-writer is connected correctly, and is functioning 
properly. 

Error Log 
� Try the process again, with a blank CD media.  Defective CD media can result in this type of 

message. 
� The CD-writer may be set at too high a speed.  As you record a CD, the Progress window has 

a green bar that shows the amount of memory buffer space available.  If that bar recedes 
completely to the left and disappears, the CD-writer has written data to the disc faster than it 
could be replenished from the source.  Recording at a lower speed usually solves this problem. 
You may need to use a lower recording speed if any of the following are different from your 
normal use of Dragon Burn: 
 
Different source device.  If you choose a different data source device, the device may not be 
able to deliver data at the speed necessary to write to the CD.  For example, an Iomega Zip 
drive transfers data at a much lower speed than a hard disk drive. 
 
Different media.  Different brands of blank CD media have different speed capabilities. 
Make sure the packaging indicates that the media is rated for the recording speed that you 
have set in the Options pane. Also, be aware that CD-RW (re-writable media) requires a much 
lower speed than CD-R  

� If you’re making a CD copy from your CD-ROM drive, try making a Disk Image File.  The 
Disk Image File will be on your hard disk drive, which is many times faster than any CD-
ROM drive. 

� If you’re making a copy of a CD, the source CD may be copy protected.  In this case, Dragon 
Burn cannot make a copy of the source CD. 
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Glossary 
AIFF 
AIFF stands for Audio Interchange File Format. It was developed by Apple Computer, Inc. for storing 
sounds on a computer.  AIFF is a flexible file format, allowing for arbitrary sampling rates, sample size, 
number of channels, and application-specific formats that may be ignored by other file formats.  
Dragon Burn supports the AIFF file format only for 44KHz, 16-bit stereo sound files. 

Blank Media 
Refers to CD media that can be recorded.  Blank media is available in two types: CD-R (that can only be 
recorded once), and CD-RW (that can be recorded, and then re-recorded with different data). 

CD-DA 
A CD-DA (Audio CD) disc contains tracks with Audio only. This type of disc is defined by the Red 
Book format standard. 

CD Extra 
CD Extra, also known as CD Plus or Enhanced CD, includes two sessions with the first session 
containing up to 98 audio tracks and the second session containing a data track written in the CD-ROM 
XA format. 

CD Media 
The CD media is the round plastic disc that fits into your CD-ROM or CD-writer drive.   

Disc-At-Once 
With Disc-At-Once writing mode, the CD-Recorder laser will not stop until the whole disc recording is 
finished. In this writing mode, the disc will be closed and there are no link blocks between any two 
tracks. 

Hybrid 

A CD that contains two (or more) separate areas, where each area has a different file format.  As used 
with CDs, this usually means an area with Windows-type files, and an area with Macintosh-type files.  
Such a disc can be used with either type of computer. 

ISO9660 Format 

A standard CD format that is widely used by Windows-based computers.  Macintosh computers can 
also read CDs that are written in this format.   

Joliet  
Microsoft implemented the Joliet file system. It is based on the ISO9660 level 3 standard. A CD created 
under the Joliet file system can only be read back under Windows 95 and Windows NT 4.0 or later. The 
number of characters allowed in a long file name is up to 64 and the number of characters allowed in a 
long directory is up to 64 characters. However, the total number of characters of the long file name plus 
its full path cannot exceed 120. 

Lead-In Area 
This is a piece of information, laying before each session that contains the TOC (Table of Contents) 
and other miscellaneous information about the disc and about the recorded tracks. 



G L O S S A R Y  

Glossary     46 

Lead-Out Area 
To indicate the end of a session, it is closed with an ending, called the Lead-Out. 

Mixed Mode CD  
A Mixed Mode CD contains a combination of CD-ROM tracks and CD-DA tracks. A Mixed Mode 
disc has a CD-ROM track as the first track and CD-DA on the following tracks. 

MPEG-1, Layer 3 (.mp3) 
MPEG-1, Layer 3, or MP3 as it is more commonly known, is the portion of the MPEG-1 specification 
dealing with the recording of audio information to a file. This standard is gaining popularity on the 
Internet. Currently, most CD drives will not play this audio format directly.   

Session 
Session refers to data written to a CD during the span of a single recording.  It is an area on the disc that 
consists of a Lead-In Area, a Program Area and a Lead-out Area. 

Session-At-Once 
With Session-At-Once writing mode, the CD-Recorder’s laser does not stop until the all data from the 
current session is written to disc.  Session-At-Once is related to the process of recording multisession 
discs.  See Multisession. 

Table of Contents (TOC) 
The Table of Contents (TOC) contains information about the disc and tracks. When you close the 
current session, the Table of Contents will be written in the Lead-In Area. With an unfinished recording 
of the disc, however, the TOC cannot be written to the disc.  

Track-At-Once 
With Track-At-Once writing mode, the CD-Recorder will record one track at a time. In between every 
track, the CD-Recorder’s laser stops while the hard disk prepares the contents of the next track.  

Wave 
A Wave (.wav) file is a file that stores analog signals (sounds) in a digital format that can be interpreted 
by a computer. 

Write Disc 
With Dragon Burn, the Write Disc button writes the selected files onto the CD media, and includes 
special coding so that the resulting CD is completely filled and cannot be used again.  Even if you select 
only a few small files, the Write Disc button will code the CD in such a way that it cannot hold any 
more data. 

Write Session 
Write Session differs from Write Disc in that it commands Dragon Burn to write the selected files as a 
"session" leaving space available on the CD for subsequent session(s).  If a CD has multiple sessions, 
each session will appear in the Finder with a separate icon.  With the Write Session button, you can 
create any number of sessions on a CD (up to the limit of available free space on the media).
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